vMax View Install and User Guide

Software version 4.5
Document Part Number: 700-0137 Rev. 15
About this Guide

The vMax View Video Management Software Install and User Guide provides information for installing the software, connecting the DVR drive interface to a computer, playing back, searching, archiving files, and troubleshooting.

Conventions Used

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
<th>Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>.AVI</td>
<td>Audio Video Interleave file is a common file format for saving video files.</td>
<td>.KML</td>
<td>Google GPS data file format</td>
</tr>
<tr>
<td>.AVR</td>
<td>Archive file for Explorer HX16, DX12, DX-HD, TX8, MX-HD, MX4, Trooper TL and TX DVRs</td>
<td>MPEG</td>
<td>Moving Picture Experts Group</td>
</tr>
<tr>
<td>.AVS</td>
<td>Archive file for Trooper TH DVRs</td>
<td>.NET</td>
<td>Microsoft software framework</td>
</tr>
<tr>
<td>.BIN</td>
<td>binary file</td>
<td>NTSC</td>
<td>National Television System Committee is the analog television system used in Canada, the U.S., Japan, South Korea, the Philippines and other parts of the Americas.</td>
</tr>
<tr>
<td>.BMP</td>
<td>Bit mapped graphics format</td>
<td>PAL</td>
<td>Phase Alternating Line system used in broadcast television systems</td>
</tr>
<tr>
<td>DVR</td>
<td>Digital Video Recorder</td>
<td>PC</td>
<td>Personal computer</td>
</tr>
<tr>
<td>.EXE</td>
<td>Self playing archive format</td>
<td>SD</td>
<td>Secure Digital memory card</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Positioning System</td>
<td>SSD</td>
<td>Solid State Drive</td>
</tr>
<tr>
<td>.GPX</td>
<td>GPS data file format for devices</td>
<td>.TXT</td>
<td>Text file format</td>
</tr>
<tr>
<td>H.264</td>
<td>High definition video compression format</td>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>HDD</td>
<td>Hard Disk Drive</td>
<td>.WMV</td>
<td>Windows Media Video file is a common file format for saving video files.</td>
</tr>
<tr>
<td>JPEG</td>
<td>Joint Photographic Experts Group</td>
<td>.XLS</td>
<td>Excel file format</td>
</tr>
</tbody>
</table>

Finding Information Online

You can find more information about Seon Design Inc. as well as its products and services at www.seon.com
# Contents

## Chapter 1  Introduction
1.1. vMax View Product Features ........................................ 1–1
1.2. vMax View Product Components ........................................ 1–2

## Chapter 2  Installation and Setup
2.1. System Requirements .................................................. 2–1
2.2. Installing or Upgrading vMax View .................................... 2–2
2.3. HX16 or TL-HD SD Card ............................................... 2–7
2.4. HDD Dock for DVR Drives .............................................. 2–8
2.4.1. Connecting the DVR HDD DOCK ................................... 2–8

## Chapter 3  Viewing and Archiving Video
3.1. Open vMax View (and Login Option) ................................. 3–2
3.1.1. User Interface ........................................................... 3–3
3.2. Viewing Video Files ..................................................... 3–8
3.2.1. Seon DVR File Formats ............................................. 3–8
3.2.2. Opening and Viewing Video From DVR Hard Drives .......... 3–8
3.2.3. Selecting HX16 Video Display Resolution ......................... 3–10
3.2.4. Opening a Video Archive ........................................... 3–11
3.2.5. Archive Validation .................................................... 3–12
3.2.5.1. Validate a Seon video archive .................................. 3–13
3.2.6. Using the Playback Window Menu .................................. 3–14
3.2.7. Video Controls .......................................................... 3–15
3.2.8. Searching for Video by Time or Events ......................... 3–16
3.2.9. View telemetry information in the Video Data tab .......... 3–17
3.3. Archiving Video Files .................................................... 3–17
3.3.1. Archive File Types .................................................... 3–18
3.3.2. Archiving Video from Date and Time .......................... 3–19
3.3.3. Archiving Video by Location ...................................... 3–21
3.3.4. Using the Archive Wizard .......................................... 3–23
3.3.4.1. Seon Format Archives ........................................... 3–24
3.3.4.2. AVI or WMV Format Archives ................................ 3–26
3.3.4.3. Self Playing Format Archives ................................ 3–28
3.3.4.4. Viewing Self Playing Archives ................................. 3–30
3.3.4.5. Blurring Privacy Zones in Archives .......................... 3–31

## Chapter 4  GPS Tracking, Telemetry, and Other Features
4.1. Saving a Still Image ..................................................... 4–2
4.2. Viewing Telemetry Information ....................................... 4–4
4.2.1. GPS ................................................................. 4–5
4.2.1.1. Archiving from GPS locations ................................. 4–5
4.2.1.2. Archiving GPS Data - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–5
4.2.2. Speed - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–6
4.2.3. Signals - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–6
4.2.4. Idle - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–6
4.2.5. G-Sensor - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–7
4.3. Menu Item Descriptions - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–8
4.3.1. File Menu - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–8
4.3.2. Options Menu - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–9
  4.3.2.1. vMax View Configuration Options - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–10
  4.3.2.2. Save a Configuration - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–11
  4.3.2.3. Load or Delete a Configuration - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–12
  4.3.2.4. Reset Default Configuration - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–12
  4.3.2.5. Users - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–13
4.3.3. Help Menu - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–14
  4.3.3.1. vMax View Software Version - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 4–14
Chapter 5  Troubleshooting
  5.1. Troubleshooting Table - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 5–1
Appendix A  Specifications
  A.1. vMax View Software - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - A–1
  A.2. DVR Event Descriptions - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - A–2
Legal Notice
  Seon Design® Inc. - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - L–1
  Contact Information - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - L–1
End-User License Agreement
For Seon Design Inc. Software
  End-User License Agreement - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - W–1
CHAPTER 1

Introduction

This chapter introduces the features of the vMax View Software (version 4.5).

1.1. vMax View Product Features

vMax View provides the following features:

**Software Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Validation</td>
<td>verify that .avr archives created with vMax View v4.2.0 and up or downloaded from vMax Commander v5.7 and up have not been corrupted or modified.</td>
</tr>
<tr>
<td>Login and user permissions</td>
<td>create and edit user names and passwords.</td>
</tr>
<tr>
<td>Easy-to-use software</td>
<td>with straightforward play, forward and rewind buttons, as well as a time line with user-adjustable zoom and scroll, and configurable auto-center/scroll.</td>
</tr>
<tr>
<td>Search</td>
<td>search for video by segment or event, or by date and time.</td>
</tr>
<tr>
<td>View</td>
<td>view 1, 4, 6, 9, 13, or 16 video channels simultaneously in high or low resolution.</td>
</tr>
<tr>
<td>Archive</td>
<td>all channels and all data can be archived as a Seon .avr or .avs file, or selected individual or multiple channels can be archived as .wmv or .avi file types; individual images can be archived as .bmp or .jpg files, or directed to the printer.</td>
</tr>
<tr>
<td>For recorded data from DVRs with version 2.0 or newer firmware, GPS data can also be archived separately in .gpx, .kml, .xls, or .txt formats for viewing in other applications.</td>
<td></td>
</tr>
<tr>
<td>A self playing .exe archive file type is available to provide unmodified video for viewers in secure computer environments who cannot install vMax View.</td>
<td></td>
</tr>
<tr>
<td>When creating .wmv and .avi archives, privacy zones can be applied to specific areas of video to block the content from view. See AVI or WMV Format Archives on page 3–26.</td>
<td></td>
</tr>
<tr>
<td>Map View</td>
<td>Displays the vehicle location on a street map.</td>
</tr>
<tr>
<td>Vehicle position is displayed in a separate window and synchronized with video playback. Displays the vehicle’s current position and complete path with start and end points.</td>
<td></td>
</tr>
<tr>
<td>Selectable map, satellite, hybrid, or terrain views of the US and Canada (Internet connection required).</td>
<td></td>
</tr>
<tr>
<td>Copy and paste the map display to MS Office™ applications (i.e., Word™, PowerPoint™, etc.).</td>
<td></td>
</tr>
<tr>
<td>Playback</td>
<td>start, end, play, pause, loop, forward or reverse at 1/8x, 1/4x, 1/2x, 1x, 2x, 4x, 8x, 16x, and 32x speeds.</td>
</tr>
<tr>
<td>Video Data</td>
<td>view Events, Alarms, and Telemetry.</td>
</tr>
<tr>
<td>Audio</td>
<td>up to 16 channels of audio are selectable</td>
</tr>
</tbody>
</table>
1.2. vMax View Product Components

The vMax View product package contains the following components:

- vMax View software CD
- DVR HDD DOCK and adapter plate (for MX, TL, and TH series drives)
  - USB3 cable
  - AC cable and power supply
- vMax View Install and User Guide

The DVR HDD DOCK connects to a USB socket on the PC running the vMax View Software. The dock supports the following Seon DVR drives:

- Explorer® HX16, DX-HD, DX12, TX8, MX-HD Basic and Plus, MX4 Basic and Plus
- Trooper® TL-HD, TL4, TL2, TH6

**Note:** Drives from the HX16 DVR require the HDD DOCK2. For more information, contact Seon Support.

For installation instructions, see [HDD Dock for DVR Drives on page 2–8](#).
CHAPTER 2

Installation and Setup

This chapter provides the following sections and procedures:

- **System Requirements, on page 2–1**
- **Installing or Upgrading vMax View, on page 2–2**
- **HX16 or TL-HD SD Card, on page 2–7**
- **HDD Dock for DVR Drives, on page 2–8**

Install the software from the CD before connecting the DVR drive interface to the computer for video playback.

### 2.1. System Requirements

Install vMax View on a computer with the following minimum system requirements:

**Table 2-1 Minimum System Requirements**

| Computer/Processor | • Intel® Core™ i5 or better for DVRs with 5 or fewer cameras; Intel® Core™ i7 or better otherwise
| | • 4-cores required for greater than 8 cameras
| | • Dedicated video card with DirectX v. 10 or higher support
| | • 1280 × 1024 monitor resolution
| | • 32 bit color quality
| | • Sound card and speakers
| | • USB 2.0 (USB 3.0 recommended)
| | • 1 GBit Ethernet adapter
| Operating Systems | • Windows 7 or higher (64-bit version required)
| | • Microsoft .NET version 4.5 or higher
| Memory | 4GB RAM or more available to the program (8GB or more total) recommended
| Disk Space | 10GB of available hard-disk space (depending on the amount of video to be stored locally)
| Drive | CD/DVD writer drive and software if the archives to be stored on CD/DVD media
| Other Requirements | Adobe® Acrobat® Reader to view the vMax View Video Management Software User Guide (available on the vMax View software CD or vMax with Tracking software CD)
| | SD card reader (optional) to access video from DVRs supporting SD cards
| | Microsoft Media Player® version 8.x or higher
| | Internet access to Google maps to display the vehicle location and track
2.2. Installing or Upgrading vMax View

vMax View requires that you have Administrator rights to the computer to install or upgrade the software. Non-administrator users can run the software.

Use the following steps to install or upgrade vMax View on your computer.

**To install or upgrade vMax View on your computer:**

1. Close all programs and temporarily disable any virus protection software running on your computer.
2. If installing for the first time, go to step 3. If upgrading vMax View, go to step 6.
3. Insert the vMax View software CD into your CD-ROM drive.
   The CD program should launch automatically on your computer.
   If the installer does not launch automatically, access the program called Seon vMax View-V4.X.X.exe from your CD by clicking on My Computer from the desktop, then clicking the CD drive.
   Double click the Seon vMax View-V4.X.X.exe program.
   The Seon vMax View Self Extractor appears with a temporary unzipping location displayed as shown.

![Seon vMax View Self Extractor](image)

4. Click Unzip.
5. Go to Step 9 (steps 6 through 8 apply only if you are upgrading vMax View).
6. To upgrade vMax View, when notified that a new version is available, contact Seon Design Technical Support using the number or email address shown on the back cover of this guide.
   Once your account information has been verified, Seon will send you the executable installation file.
7. When downloading is complete, go to the file location and double click the application file.
8. In the Open File — Security Warning window, click Run.
The Seon vMax View Setup Wizard appears as shown.

9. Click **Next**.

The License Agreement window appears.

10. Review the agreement and, if you accept, click on **I accept the agreement** to continue.

11. Click **Next**.

The Setup Destination Location window appears. Seon recommends allowing installation in the default directory.
12. Click **Next**.
   The Select Additional Tasks window appears with the Create a desktop icon check box selected and the Enable Login Support check box cleared.

![Select Additional Tasks Window](image)

13. If you require login support for vMax View at your location, select the Enable Login Support check box.

14. Click **Next**.

15. In the Setup confirmation dialog that appears, click OK.

![Setup Confirmation Dialog](image)

On the PC, the Administrator must ensure that anyone who is going to be logging into vMax View needs to have full read/write access to the folder where vMax View is installed.
The following image shows the folder properties window where the settings are done.

![Folder Properties Window]

16. In the Select Additional Tasks window, click **Next**.
   The Ready to Install window appears.

![Ready to Install Window]

17. Verify the settings and click **Install**.
vMax View installs on your computer.

18. Click Finish to exit Setup.

19. Launch vMax View.

20. If running Windows 10 and .NET 4.5 is not installed on the PC, click Download and Install this feature in the dialog that appears.

Note: An Internet connection is required to download the .NET 4.5 version from Microsoft for this installation.
21. When the progress bar completes and the install is verified, click **Close**.

22. Restart vMax View.

23. See Chapter 3, Viewing and Archiving Video for more information on logging in and using vMax View.

### 2.3. HX16 or TL-HD SD Card

vMax View can view and archive video from the HX16 or TL-HD DVR’s optional SD card.

The SD card records the low resolution video as a backup drive on the DVRs.

The SD card is connected to the computer using the SD card slot or a USB SD card reader.

vMax View finds the SD card exactly like a DVR hard drive.
2.4. HDD Dock for DVR Drives

The DVR HDD DOCK is designed to accept HX, DX, TX, MX, TL and TH series DVR drives.

The HX drive sits in the single-width, double-depth slot in the front of the dock.
It accepts the DX and TX series drives by removing the supplied adapter plate.
It requires AC power to read drives and communicates with the PC via USB.

2.4.1. Connecting the DVR HDD DOCK

Once vMax View has been installed, connect the DVR HDD DOCK to the computer as shown.

1. Connect the USB cable connector to a USB port on your computer.
2. Connect the power supply to the DVR HDD DOCK and to AC power.
3. Insert the DVR drive. Remove the adapter plate for TX and DX drives.
4. Power on the DVR HDD DOCK by pressing the power button between the AC and USB cables.

Note: For proper program operation, turn off the DVR HDD DOCK when switching drives.
Some Windows operating systems may not support powered removal of hard drives.
CHAPTER 3

Viewing and Archiving Video

This chapter describes how to view, archive, and save files with the vMax View Video Management Software.

This chapter contains the following sections and procedures:

Open vMax View (and Login Option), on page 3–2

User Interface, on page 3–3

Viewing Video Files, on page 3–8

Seon DVR File Formats, on page 3–8

Opening and Viewing Video From DVR Hard Drives, on page 3–8

Opening a Video Archive, on page 3–11

Archive Validation, on page 3–12

Using the Playback Window Menu, on page 3–14

Video Controls, on page 3–15

Searching for Video by Time or Events, on page 3–16

View telemetry information in the Video Data tab, on page 3–17

Archiving Video Files, on page 3–17

Archive File Types, on page 3–18

Archiving Video from Date and Time, on page 3–19

Archiving Video by Location, on page 3–21

Using the Archive Wizard, on page 3–23

Seon Format Archives, on page 3–24

AVI or WMV Format Archives, on page 3–26

Self Playing Format Archives, on page 3–28

Viewing Self Playing Archives, on page 3–30

Blurring Privacy Zones in Archives, on page 3–31
3.1. Open vMax View (and Login Option)

The login function is optional. Login is disabled by default during installation.

To enable login when installing, see Installing or Upgrading vMax View, on page 2–2.

It can also be enabled and disabled from the Options > Users menu settings.

See also Users, on page 4–13.

To open vMax View:

1. Click the vMax View icon on the desktop to launch the application.

   ![vMax View icon](image1.png)

   If the login requirement has been enabled, the vMax View login prompt appears.

   ![vMax View login prompt](image2.png)

   If the login requirement has been disabled, the vMax View user interface appears.

   See User Interface, on page 3–3.

2. Enter the user name and password assigned to you by the system administrator.

   **Security Tip: Update Password**
   
   The default user name and password is “admin”. For security purposes, Seon recommends that the user default login and system settings passwords should be changed. Seon is not responsible if the changed password is lost or forgotten.

3. If needed, select a language (English, Español) from the Language drop down list.
   
   When logged in, vMax View menu and feature text displays in the language selected.

4. Optionally, select the check box to have vMax View remember your user name and language.

5. Click Login.

   The vMax View splash screen appears, then the application opens.
3.1.1. User Interface

Use the following figure and table to locate and identify vMax View software features.

![vMax View Video Management Software User Interface](image)

**Figure 3-1** vMax View Video Management Software User Interface

**Table 3-1** vMax View Software Features

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Video Selection</td>
<td>Displays the name, capacity, and DVR type of any hard drives and SD cards connected to the computer. Click the file folder icon to browse for video through the File Menu window.</td>
<td>Load File</td>
</tr>
<tr>
<td>2</td>
<td>Calendar</td>
<td>Select the month and year search range.</td>
<td>Current</td>
</tr>
</tbody>
</table>
| 3    | Calendar      | Select the day of month search range. Days on the calendar containing video are highlighted as follows:  
Green: current day  
Gray: recorded data present  
Red: alarms recorded | Current     |
| 4    | Time Search   | Find or set the hour, minute, and second starting point of data on the selected day.  
Select with up/down arrows or use the cursor to enter values.  
Click Search to find event and alarm segments within the selected search ranges. If there is no available data for the date and time selected, the system retrieves the closest following segment. | Current     |
Choose from 1, 4, 6, 9, 13, or 16 view channel options. The view options display as shown by default:

Select a source camera for audio output from one of the displayed camera titles in the drop down menu. Adjust the volume using the slider. Mute audio if desired. Only one channel can play at a time. The audio level setting is saved when the application is re-opened.

Select tabs to view Event or Alarm recordings and Time or Telemetry details of recordings.

On the Events tab, select from the following Event Types:
- Session Events: recorded events are listed
- Information: DVR system information clips are listed
- All: event and information recordings are listed

On the Alarm tab, select from the alarms to view the associated video.

On the Telemetry tab click the GPS Speed Signals, Idle, or G Sensor icon to view instances of telemetry events and associated video.

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td><strong>Video Display</strong></td>
<td>Choose from 1, 4, 6, 9, 13, or 16 view channel options. The view options display as shown by default:</td>
<td>Channel count of the DVR type used for recording</td>
</tr>
<tr>
<td>7</td>
<td><strong>Audio</strong></td>
<td>Select a source camera for audio output from one of the displayed camera titles in the drop down menu. Adjust the volume using the slider. Mute audio if desired. Only one channel can play at a time. The audio level setting is saved when the application is re-opened.</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td><strong>Video Data</strong></td>
<td>Select tabs to view Event or Alarm recordings and Time or Telemetry details of recordings. On the Events tab, select from the following Event Types: Session Events: recorded events are listed Information: DVR system information clips are listed All: event and information recordings are listed On the Alarm tab, select from the alarms to view the associated video. On the Telemetry tab click the GPS Speed Signals, Idle, or G Sensor icon to view instances of telemetry events and associated video.</td>
<td>Events, Session Events</td>
</tr>
</tbody>
</table>
### Table 3-1 vMax View Software Features

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td></td>
<td>Controls frame and fast reverse, play, pause, forward, and loop functions. Performance depends on computer processing power and camera(s) resolution settings.</td>
<td>Pause</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Seek Reverse</td>
<td>Jumps video to beginning of the selected clip. If the video is at the beginning of the clip, it will jump to the beginning of the previous segment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fast Reverse</td>
<td>Reverses video from 1x, 2x, 4x, 8x, 16x, 32x speeds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Slow Reverse</td>
<td>When video is playing, this button reverses video slowly from 1/8x, 1/4x, 1/2x speeds. When video is paused, this button reverses video frame by frame each time clicked.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Play/Pause</td>
<td>Stops/Starts Video. Transitions from Play to Pause.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Slow Forward</td>
<td>When video is playing, this button forwards video slowly from 1/8x, 1/4x, 1/2x speeds. When video is paused, this button forwards video frame by frame each time clicked.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fast Forward</td>
<td>Forwards video from 1x, 2x, 4x, 8x, 16x, 32x speeds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Seek Forward</td>
<td>Jumps video to end of the selected clip. If the video is at the end of the clip, it will jump to the beginning of the next segment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Loop Clip</td>
<td>Continually wraps the same clip at the same speed and direction until further user interaction.</td>
</tr>
</tbody>
</table>
Start/End Archive Clip

Populate these fields with the start and end time of the video segment you want to archive. The field time data can be entered manually or by using the playback controls.

Use the playback controls to locate the archive starting point and click the Start Archive Clip icon to enter that time.

Use the playback controls to locate the archive ending point and click the End Archive Clip icon to enter that time.

Start Archive Clip
Click to enter the start time of the video segment to archive.

End Archive Clip
Click to enter the end time of the video segment to archive.

Archive ...
Click to save the selected video segment.

Day/Hour Toggle Switch
Choose from Day or Hour to toggle the time scale on the Segment Graph.

Day

Clip Time Reference
Clip Time Reference. These text areas display the labels with the start/end time of the selected clip.

Far left reference: fixed start time of the segment, (00:00:00)
Far right reference: fixed end time of the segment, (00:00:00)
Center Reference: active current playing time of the segment (DD/MM/YYYY 00:00:00), playback status (Play 1x FWD), clip duration (00:00:00)

Segment Graph
The Segment Graph is an interactive map of the media available for the selected day. The Segment Graph is selectable in Daily or Hourly mode.

Daily Mode:
The daily view graph displays the days video over 24 hours.

Hourly Mode:
The hourly graph displays the video within an hour from the first recorded video.

Segment Types:
Green: continuous recorded data clip
Red: recorded alarm event
White: recorded information or system error event
Magenta: Active GPS route information, for recorded data from DVRs with version 2.0 or newer firmware

---

Table 3-1 vMax View Software Features

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Start/End Archive Clip</td>
<td>Populate these fields with the start and end time of the video segment you want to archive. The field time data can be entered manually or by using the playback controls. Use the playback controls to locate the archive starting point and click the Start Archive Clip icon to enter that time. Use the playback controls to locate the archive ending point and click the End Archive Clip icon to enter that time. Click to enter the start time of the video segment to archive. Click to enter the end time of the video segment to archive.</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Archive ...</td>
<td>Click to save the selected video segment.</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Day/Hour Toggle Switch</td>
<td>Choose from Day or Hour to toggle the time scale on the Segment Graph.</td>
<td>Day</td>
</tr>
<tr>
<td>13</td>
<td>Clip Time Reference</td>
<td>Clip Time Reference. These text areas display the labels with the start/end time of the selected clip. Far left reference: fixed start time of the segment, (00:00:00) Far right reference: fixed end time of the segment, (00:00:00) Center Reference: active current playing time of the segment (DD/MM/YYYY 00:00:00), playback status (Play 1x FWD), clip duration (00:00:00)</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Segment Graph</td>
<td>The Segment Graph is an interactive map of the media available for the selected day. The Segment Graph is selectable in Daily or Hourly mode. Daily Mode: The daily view graph displays the days video over 24 hours. Hourly Mode: The hourly graph displays the video within an hour from the first recorded video. Segment Types: Green: continuous recorded data clip Red: recorded alarm event White: recorded information or system error event Magenta: Active GPS route information, for recorded data from DVRs with version 2.0 or newer firmware</td>
<td>Day</td>
</tr>
</tbody>
</table>
### Table 3-1 vMax View Software Features

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>View from 1, 4, 6, 9, 13, or 16 viewing sections. Right-click on a viewing section to select display options. Double click on a viewing section to expand it to full screen.</td>
<td>Number of viewing sections based on channel count of the DVR type used for recording</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Video Zoom:</strong></td>
<td>With the mouse in a viewing section, the + and - icons appear at the top-left. Click an icon to zoom in or out on the video in the window. You can also click a viewing section and scroll the mouse wheel to zoom in and out. The zoom range is from - x0.25 to + x8.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Resolution:</strong></td>
<td>For video from HX16 DVRs, with the mouse in a viewing section, the H and L icons appear at the bottom-right. Click an icon to switch the video to high or low resolution.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Undock and Re-dock View Window:</strong></td>
<td>With the mouse in a viewing section, the Unlock icon appears at the top-right. Click the icon to open the viewing section in a new window. When the viewing section is undocked, click the Re-dock icon to have the viewing section re-dock into the playback window.</td>
<td></td>
</tr>
</tbody>
</table>
3.2. Viewing Video Files

This section provides the following video file viewing and archiving procedures:

Seon DVR File Formats, on page 3–8
Opening and Viewing Video From DVR Hard Drives, on page 3–8
Opening a Video Archive, on page 3–11
Archive Validation, on page 3–12
Using the Playback Window Menu, on page 3–14
Video Controls, on page 3–15
Searching for Video by Time or Events, on page 3–16

3.2.1. Seon DVR File Formats

Use vMax View to view .avr or .avs archive file formats for Explorer HX, DX, TX, MX, and Trooper TL and TH series DVRs. The files are stored on your computer.

3.2.2. Opening and Viewing Video From DVR Hard Drives

To open a video file from the DVR HDD DOCK or SD card reader:

1. In the vMax View drive window, click the down arrow in the Video Selection box and select the DVR drive connected to the computer.
   
   vMax View sees the information from the dual HX, DX and TX DVR drives as a single drive full of data.
   
   For DVRs using the SD card option, the SD card is detected as a Seon HX or TL DVR drive.

   ![Hard drive from DX-HD DVR](image1)

   ![SD Card from TL-HD DVR](image2)

2. Click the File icon.

   vMax View loads the drive data. A progress bar appears. The process may take a few minutes depending on the storage capacity of the drive being loaded.

   ![Progress bar](image3)
The Video Display area screens (by default, based on the channel count of the DVR type used for recording) load the most recent recording on the drive.

The date and time search area indicates where video has been recorded, and the start time of the most current recording on the drive.

The Video Data area tabs populate with information from the drive.

3. Using the Calendar or Video Data Events or Alarms tabs, select the recording you want to view. For more information see DVR Event Descriptions, on page A–2.
4. Click the Play/Pause button. The selected video file opens and plays back video footage. Depending on the number of cameras installed, there may be multiple video channels displayed.

5. In the Video Display area, select a Video Display option that shows the number of video channels required.

3.2.3. Selecting HX16 Video Display Resolution

vMax View can display either high or low resolution video from HX16 DVRs. DX TX MX TL drives display in high resolution only. SD card video records only in low resolution.

Note: Playback in high resolution requires more processing power. If you experience playback problems with multi-channel HX16 video, select high resolution for channels of interest, and display other channels in low resolution to reduce the load on your computer’s system resources.

You can select the resolution to display in different ways:

Select all:
With video from an HX16 DVR displaying in vMax View, from the Options—Resolution menu, click All High or All Low to display all cameras in the same resolution.
Select each:
In a selected video display channel, select H or L to view the video in high or low resolution.

3.2.4. Opening a Video Archive

Open a segment of video previously archived in vMax View or downloaded from vMax Commander.

To open a Video Archive:
1. From the Video Selection drop down list, select Load File.

2. Click the Open Media icon to browse through your computer’s local disk to open a Seon DVR archive (*.avr or *.avs).

3. In the Select an Archive dialog, select a file.

4. Click Open.

5. In vMax View, click the Play/Pause button to start the video playback.
3.2.5. Archive Validation

The Validate Archive feature verifies the integrity of Seon format archives saved as .avr files. Archives created from TH-series DVRs in .avs format cannot be validated. For more information, see Archive File Types, on page 3–18.

The validation is applicable to .avr video archives accessed in the following ways:

- created in vMax View version 4.2.0 and up.
- downloaded from a DVR by vMax Commander v5.7 and up.

Seon archive video is checked for validity whenever users create an .avr format archive from the downloaded file.

- If it is valid, it can be archived.
- If it is corrupted or modified, it can be archived but that archive can’t be validated.

Important:

- Only .avr archives created in vMax View 4.2.0 and up or downloaded from a DVR by vMax Commander v5.7 and up can be validated.
- The Validate Archive function does not operate or apply when creating new archives from archive files that were created with earlier versions of vMax View.
- Archives created in vMax View 4.2.0 and up, or downloaded from a DVR by vMax Commander v5.7 and up cannot be played in earlier versions of vMax View.
3.2.5.1. Validate a Seon video archive

1. In the vMax View File menu, click Open.
2. In the Select an Archive window, choose an archive created in vMax View 4.2.0 and up or downloaded by vMax Commander 5.7 and up.
3. Click Open.
4. From the File menu, click Validate Archive.

An Archive Validation dialog appears, as well as archive status information beside the progress bar.

5. If the Archive Validation dialog says that the Archive has been Validated, click OK and the file will open, ready for viewing or re-archiving.
6. If the Archive Validation dialog says that the Archive has been corrupted or modified, the file can be played but cannot be validated.
7. Click OK, and the file will open.
3.2.6. Using the Playback Window Menu

To display the Playback Window menu, right-click on a viewing section in the vMax View playback window. The menu appears. The following image and table describe the menu options.

![Playback Window Menu](image)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Camera</td>
<td>Select a camera channel from 1 to 16 to play in the selected viewing section.</td>
</tr>
<tr>
<td>This Camera’s Audio</td>
<td>Play the audio from this camera.</td>
</tr>
<tr>
<td>Display Mode</td>
<td>Select from 1, 4, 6, 9, 13, and 16 video channel views. If no camera was assigned to a video channel, No Media Available appears over the black background.</td>
</tr>
</tbody>
</table>
| Display Telemetry   | Select from the following telemetry options. The information displays in the selected view channel. Telemetry data may not be available on some DVR models.  
                        • GPS — view and archive location, heading, and route information on a map.  
                        • Speed — view current speed in MPH or KPH, as set in DVR.  
                        • Signals — view vehicle signal status, up to 10 signals.  
                        • Idle — view vehicle idle status.  
                        • G Sensor — view G Sensor data.                                                                                                     |
| Map Style           | When the GPS telemetry view is open, select from the following map viewing options:  
                        • Streets  
                        • Satellite  
                        • Hybrid  
                        • Terrain                                                                                                                             |
| Save .jpg Image     | Click to save the selected video image as a picture on your computer.                                                                          |
| Print Image         | Click to view the Print preview window. From the Print preview window, click the print icon. vMax View uses the Windows default printer.         |
3.2.7. Video Controls

vMax View provides video search controls and playback controls as described in the following table. The playback speed setting applies to both the continuous play and the forward/reverse controls.

To play a video file:

1. Click the Play/Pause button to start the video clip.

In Play mode, change the playback speed by clicking on the Fast and Slow Forward or Reverse buttons. In Pause mode, the Slow buttons increment the video frame by frame.

To pause a video file:

Press the Play/Pause button.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controls</td>
<td>Controls reverse, play, pause, forward, and loop functions. Performance depends on computer processing power and camera(s) resolution settings.</td>
</tr>
<tr>
<td>Seek Reverse</td>
<td>Jumps video to beginning of the selected clip. If the video is at the beginning of the clip, it will jump to the beginning of the previous segment.</td>
</tr>
<tr>
<td>Fast Reverse</td>
<td>Reverses video from 1x, 2x, 4x, 8x, 16x, 32x speeds.</td>
</tr>
<tr>
<td>Slow Reverse</td>
<td>Slowly reverses video from 1/8x, 1/4x, 1/2x speeds. When video is paused, this button reverses video frame by frame each time clicked.</td>
</tr>
<tr>
<td>Play/Pause</td>
<td>Starts/Stop the video. Transitions from Play to Pause.</td>
</tr>
<tr>
<td>Slow Forward</td>
<td>Slowly forwards video from 1/8x, 1/4x, 1/2x speeds. When video is paused, this button forwards video frame by frame each time clicked.</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>Forwards video from 1x, 2x, 4x, 8x, 16x, 32x speeds.</td>
</tr>
<tr>
<td>Seek Forward</td>
<td>Jumps video to end of the selected clip. If the video is at the end of the clip, it will jump to the beginning of the next segment.</td>
</tr>
<tr>
<td>Loop Clip</td>
<td>Continually wraps the same clip at the same speed and direction until further user interaction.</td>
</tr>
</tbody>
</table>
3.2.8. Searching for Video by Time or Events

**Search by time:**

1. To search a video file by time, select a Calendar date containing video you want to see, and press **Search**.

   Video recorded at the selected time loads in the Playback window.

2. Press **Play**.

**Search by Event/Alarm:**

1. To search a video file by event or alarm, double-click an event or alarm date and time from the Events or Alarms tab list.

   For more information see **DVR Event Descriptions, on page A–2**.

2. When the video loads, press **Play**.
3.2.9. View telemetry information in the Video Data tab

1. In the Video Data area, select the Telemetry tab.
2. Click the icons to display the telemetry information in text format on the tab.

3.3. Archiving Video Files

This section provides the following video archiving procedures:

- Archive File Types, on page 3–18
- Archiving Video from Date and Time, on page 3–19
- Archiving Video by Location, on page 3–21
- Using the Archive Wizard, on page 3–23
- Seon Format Archives, on page 3–24
- AVI or WMV Format Archives, on page 3–26
- Self Playing Format Archives, on page 3–28
- Viewing Self Playing Archives, on page 3–30
- Blurring Privacy Zones in Archives, on page 3–31
### 3.3.1. Archive File Types

vMax View provides the following options for archiving audio/video and telemetry data on your computer’s disk.

You can also print or save individual video images as .bmp or .jpg files.

<table>
<thead>
<tr>
<th>Archive File Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.avr</td>
<td>Seon DVR video file format for HX16, DX-HD, DX12, TX8, MX-HD, MX4, TL-HD, TL4, TL2</td>
</tr>
<tr>
<td></td>
<td>Archives one or more video channels and a matching number of audio channels.</td>
</tr>
<tr>
<td></td>
<td>Archives video to a local or network computer, or storage device.</td>
</tr>
<tr>
<td></td>
<td>Includes all video, audio, alarms, events, GPS, telemetry information.</td>
</tr>
<tr>
<td></td>
<td>See Seon Format Archives, on page 3–24</td>
</tr>
<tr>
<td>.avs</td>
<td>Seon DVR video file format for TH series</td>
</tr>
<tr>
<td></td>
<td>as above</td>
</tr>
<tr>
<td>.avi</td>
<td>Universally playable Audio Video Interleaved video format</td>
</tr>
<tr>
<td></td>
<td>Archives one or more video channels and one audio channel.</td>
</tr>
<tr>
<td></td>
<td>Privacy zones option available. See AVI or WMV Format Archives, on page 3–26.</td>
</tr>
<tr>
<td></td>
<td>Includes signal/speed/GPS telemetry information available as overlay text.</td>
</tr>
<tr>
<td></td>
<td>The archived files can be viewed in Apple QuickTime, Windows Media Player, or other media player applications.</td>
</tr>
<tr>
<td>.exe</td>
<td>Seon DVR video file format for HX16, DX-HD, TX8, MX-HD, TL-HD, TL4, TL2, TH6</td>
</tr>
<tr>
<td></td>
<td>Archived video and data as a self playing file.</td>
</tr>
<tr>
<td></td>
<td>Archives one or more video channels and one audio channel.</td>
</tr>
<tr>
<td></td>
<td>Archives video to a local or network computer, or storage device.</td>
</tr>
<tr>
<td></td>
<td>Includes all video, audio, alarms, events, GPS, telemetry information.</td>
</tr>
<tr>
<td></td>
<td>MX4 and DX12 DVRs not supported.</td>
</tr>
<tr>
<td></td>
<td>See Self Playing Format Archives, on page 3–28</td>
</tr>
<tr>
<td>.gpx</td>
<td>Garmin device viewable GPS data file</td>
</tr>
<tr>
<td></td>
<td>Save the GPS data as a file that can open in Garmin GPS units. DVRs v.2.0 or newer firmware.</td>
</tr>
<tr>
<td></td>
<td>See Archiving Video from Date and Time, on page 3–19.</td>
</tr>
<tr>
<td>.kml</td>
<td>Google web viewable GPS data file</td>
</tr>
<tr>
<td></td>
<td>Saves the GPS data as a file that opens on Google Earth web mapping application. DVRs v.2.0 or newer firmware.</td>
</tr>
<tr>
<td></td>
<td>See Archiving Video from Date and Time, on page 3–19.</td>
</tr>
<tr>
<td>.txt</td>
<td>Text format GPS data file</td>
</tr>
<tr>
<td></td>
<td>Saves the GPS data as a file that opens in text viewing applications. DVRs v.2.0 or newer firmware.</td>
</tr>
<tr>
<td></td>
<td>See Archiving Video from Date and Time, on page 3–19.</td>
</tr>
<tr>
<td>.xls</td>
<td>Excel format GPS data file</td>
</tr>
<tr>
<td></td>
<td>Saves the GPS data as a file that opens in Excel spreadsheet application. DVRs v.2.0 or newer firmware.</td>
</tr>
<tr>
<td></td>
<td>See Archiving Video from Date and Time, on page 3–19.</td>
</tr>
<tr>
<td>.wmv</td>
<td>Universally playable Windows Media Video format</td>
</tr>
<tr>
<td></td>
<td>Archives one or more video channels and 1 audio channel.</td>
</tr>
<tr>
<td></td>
<td>Privacy zones option available. See AVI or WMV Format Archives, on page 3–26.</td>
</tr>
<tr>
<td></td>
<td>Includes signal/speed/GPS telemetry information available as overlay.</td>
</tr>
<tr>
<td></td>
<td>The archived files can be viewed in Windows Media Player or other media player applications.</td>
</tr>
</tbody>
</table>
3.3.2. Archiving Video from Date and Time

To archive video and telemetry data using the Search and Play controls:

1. Use the video playback or search controls to view the start date and time of the video you want to archive.
   By default, vMax View archives video from all cameras in the view.
2. Click Ctrl and click channels to include multiple camera views.
3. Locate the incident in Play mode and click Pause.
4. Click the Start Archive Clip icon to set the start date and time.
5. Locate the end of the video you want to archive in Play mode and click Pause.
6. Click End Archive Clip.
7. Click Archive ...

**Note:** Archive video, created in vMax View 4.2.0 and up or downloaded from a DVR by vMax Commander v5.7 and up, is checked for validity whenever users create an archive.
   If the video is valid, it can be archived.
   If it is corrupted or modified, it can be archived but that archive cannot be validated.
   See Archive Validation, on page 3–12 for details.

8. In the Save window, choose a directory where you want to save the archive file.
9. Name the archive file.
10. Select the archive file format from the Save as type menu.
Save Menu Archiving Features

<table>
<thead>
<tr>
<th>Save as type</th>
<th>Choose from the following file formats:</th>
</tr>
</thead>
<tbody>
<tr>
<td>.avr</td>
<td>Seon archive format for Explorer HX16, DX-HD, DX12, TX8, MX-HD, MX4, and Trooper TL series DVRs</td>
</tr>
<tr>
<td>.avs</td>
<td>Seon archive format for Trooper TH series DVRs</td>
</tr>
<tr>
<td>.exe</td>
<td>Self playing archive format for Explorer HX16, DX-HD, TX8, MX-HD, Trooper TL and TH series DVRs</td>
</tr>
<tr>
<td>.avi</td>
<td>Audio Video Interleaved format</td>
</tr>
<tr>
<td>.wmv</td>
<td>Windows Media Viewer format</td>
</tr>
<tr>
<td>.txt</td>
<td>GPS data text format</td>
</tr>
<tr>
<td>.xls</td>
<td>GPS data Excel format</td>
</tr>
<tr>
<td>.kml</td>
<td>GPS data Google format</td>
</tr>
<tr>
<td>.gpx</td>
<td>GPS data Garmin format</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Text overlay</th>
<th>Select to include the text overlay in the video archive file.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Text color</th>
<th>Select the text overlay color. Choose from white, green, or yellow.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Archive with audio</th>
<th>Include camera audio in archive. Selected by default.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Select privacy zones</th>
<th>Select to create blurred areas in the video.</th>
</tr>
</thead>
</table>

11. If you select .avi or .wmv formats, you can select text, audio and privacy options.

If you enable Select privacy zones, the privacy zones window will appear when you click Save.

For details, go to Blurring Privacy Zones in Archives, on page 3–31.

12. Click Save.

The Archive Progress dialog appears.

![Archive Progress dialog](image)

**Important:** If the progress indicator stops for more than five minutes, the computer’s disk may be full, or the video conversion may have failed. Click **Cancel** to stop archiving.
3.3.3. Archiving Video by Location

When you know the location of an incident and you want to archive video from a vehicle in the vicinity, you can select archive start and end points from map view in vMax View. The map view displays GPS data from DVRs using version 2.0 or newer firmware. See GPS, on page 4–5 for more information.

To archive video and telemetry data using the GPS map view:

1. In a video channel in the viewing area, right click and select Display Telemetry, then GPS.

2. In the map view, locate the position where you want to start an archive and click to select the archive start time.

3. In the map view, locate the position where you want to end an archive and click to select the archive end time.

4. In the Save window that opens, select the archive saving location and file name.

5. In the Save as type drop down list, you can save the archive in a video format, or save the GPS data (without video) as a file in .txt, .xls, .kml, or .gpx data formats for viewing the GPS information in other applications.

6. Click Save to create the archive.
3.3.4. Using the Archive Wizard

Use the Archive Wizard to output video archive files that can be viewed in vMax View, third party video players like Windows Media Player, or in a self playing format.

**To archive video clips using the Archive Wizard:**
1. Use the video playback or search controls to view the start date and time of the video you want to archive.
2. Select the camera view(s) to output to an archive. To archive a specific camera view, select the camera view to output to an archive. Ctrl and click on other camera views to select them.
3. Locate the start and end times of the video segment to archive.
4. Click **File > Archive Wizard** to start the Archive Wizard.

**Note:** Archive video, created in vMax View 4.2.0 and up or downloaded from a DVR by vMax Commander v5.7 and up, is checked for validity whenever users create an archive in .avr file format (for more information, see Archive File Types, on page 3–18).

If the video is valid, it can be archived.
If it is corrupted or modified, it can be archived but that archive cannot be validated.
See Archive Validation, on page 3–12 for details.
5. Review the viewing option descriptions and, depending on your requirements, select from **Seon file format**, **Basic/Advanced**, or **Seon self playing**:

**Seon file format**: the Seon secure archive format will contain the exact video, audio and telemetry data recorded by the DVR and can only be viewed in vMax View. See **Seon Format Archives**, on page 3–24.

Or

**Basic/Advanced**: the basic or advanced archive formats have the following options:

- viewable on computers that do not have vMax View installed
- file size and video quality adjustment range
- telemetry data text overlay
- privacy zone application to visually block specific video content

See **AVI or WMV Format Archives**, on page 3–26.

Or

**Seon self playing**: the Seon self playing archive format provides a secure evidence quality video that does not require a video player.


### 3.3.4.1. Seon Format Archives

Use the Seon format to create secure video archives such as for evidence viewing.

This procedure is continued from step 5 of Using the Archive Wizard, on page 3–23.

1. With the **Seon** file format selected, click **Next**.

   The next Archive Wizard menu dialog opens. The Archive options are not enabled for Seon native format archives.

2. Click the File name field or the folder icon.

   The Windows Save As dialog opens.

3. In Save As, select a saving location and enter a file name. Click **Save**.
The Save As dialog closes and the file name and location appears in the Archive Wizard’s File name field.

4. Click **Next**.

   The last Archive Wizard menu dialog opens.

![Archive Wizard Dialog](image)

5. Click **Finish**.

   The Archiving progress bar displays.

   When the progress completes, the archive is ready for viewing.

![Archiving Progress](image)

The archived files can only be viewed in vMax View.

**Important:** If the progress indicator stops for more than five minutes, the computer’s disk may be full or the video conversion may have failed. Click **Cancel** to stop archiving.
3.3.4.2. AVI or WMV Format Archives

Use this format for creating reference video archives that can be viewed on computers that do not have vMax View installed.

This procedure is continued from step 5 of Using the Archive Wizard, on page 3–23.

1. With the Basic or Advanced option selected, click Next.

The next Archive Wizard menu dialog opens.

2. Adjust the slider depending on the video quality you require and the file size you can accommodate.

3. Click Next.

The next Archive Wizard menu dialog opens.

4. Click the File name field or the folder icon.

The Windows Save As dialog opens.

5. In Save As, select a saving location and enter a file name. Click Save.
6. Select the Enable Overlay check box to display telemetry information in text form in the Archive.
   The text color menu becomes active.

7. In the Text Color menu, choose from white, yellow, or green to have the overlay text appear in that color.

8. Select the Archive with Audio check box to include the selected audio channels.

9. If required, enable Select privacy zones to create blurred areas in the video.
   See Blurring Privacy Zones in Archives, on page 3–31.

10. Click Next.
    The last Archive Wizard menu dialog opens.

11. Click Finish.
    The Archiving progress bar displays.
    When the progress completes, the archive is ready for viewing.
    The .wmv or .avi archived files can be viewed in any standard media player.

**Important:** If the progress indicator stops for more than five minutes, the computer’s disk may be full or the video conversion may have failed. Click **Cancel** to stop archiving.
3.3.4.3. Self Playing Format Archives

Use this format to create secure video archives such as for evidence viewing, and that can be viewed on computers that do not have vMax View or any other video players installed.

This procedure is continued from step 5 of Using the Archive Wizard, on page 3–23.

1. With the Seon self playing format option selected, click Next.

   The next Archive Wizard menu dialog opens.

   The Archive options are not enabled for Seon native format archives.

2. Click the File name field or the folder icon.

   The Windows Save As dialog opens.

3. In Save As, select a saving location and enter a file name. Click Save.

   The Save As dialog closes and the file name and location appears in the Archive Wizard’s File name field.

4. Click Next.

   The last Archive Wizard menu dialog opens.
5. Click **Finish**.

   The Archiving progress bar displays.

   When the progress completes, the archive is ready for viewing.

   ![Archive Progress](image_url)

   **Important:** If the progress indicator stops for more than five minutes, the computer’s disk may be full or the video conversion may have failed. Click **Cancel** to stop archiving.
3.3.4.4. Viewing Self Playing Archives

Seon .exe self playing archives display one camera view at a time, as selected in the Playback Control window.

The Stand Alone Player window can play back high definition video and standard definition video at full resolution, as shown.

In the Playback Control, select the camera to view and click Play to start. Click Pause or Resume to continue. Also, you can press the space bar to stop and start the video. On the progress bar below the video area, click anywhere to play video from the selected point.
3.3.4.5. Blurring Privacy Zones in Archives

Use this feature to blur the faces of innocent passengers throughout the video to protect their privacy.

Privacy zone blurring can be applied to either .avi or .wmv file formats.

1. Select the **Select privacy zones** check box to enable blurring specific areas of archive video.

2. Click **Next**.

   The Privacy Zone Selection window appears.

3. Move the mouse cursor over the video areas and the cursor becomes a cross hair.
4. Within a camera view, click and drag the cross hair to define the area to be blocked from view. Ensure the cross hair remains within the camera view’s boundaries, or selected areas won't register properly.

5. Click **Clear Selections** to erase any selections made in this window.

6. When all privacy zones have been selected, click **Next**.

---

**Note:** The privacy zone to block from view (blur) stays fixed in the area you define for the duration of the video. Ensure your selection is large enough to account for passenger movement, so faces do not become visible.
The last Archive Wizard menu dialog opens.

7. Click **Finish**.

The Archiving progress bar displays.

The .wmv or .avi archived files can be viewed in any standard media player.

**Important:** If the progress indicator stops for more than five minutes, the computer’s disk may be full or the video conversion may have failed. Click **Cancel** to stop archiving.
GPS Tracking, Telemetry, and Other Features

This chapter describes how to view, archive, and save files with the vMax View Video Management Software.

This chapter contains the following sections and procedures:

- Saving a Still Image, on page 4–2
- Viewing Telemetry Information, on page 4–4
  - Archiving GPS Data, on page 4–5
- Menu Item Descriptions, on page 4–8
- Users, on page 4–13
- Help Menu, on page 4–14
4.1. Saving a Still Image

Sometimes a still image is more useful than a video to identify a person or event on or near a vehicle.

In vMax View you can pause video at any time and create a .bmp or .jpg image from the display area.

You can also edit the images in other graphic applications to blur or call attention to parts of the image.

To save individual video images to .bmp or .jpg files:

1. In the video display area, select the video channel or channels you wish to save as a still image.
   Using the Ctrl or Shift keys, you can select multiple channels.

2. Right-click on a selected video channel.

3. In the pop up menu, select Save .jpg Image...
   The Save window appears.

4. Choose a file saving location.
5. Enter a file name that identifies the video channel, date, and any other details required.

6. Click on the Save as type arrow and select either JPEG (*.jpg) or BMP (*.bmp) file format.
   JPEG files are commonly used for storing and sending photographs on the Internet. Bitmap files are not compressed and are not generally ideal for transferring images on the Internet.

7. Choose whether to save each channel as a separate image or to save all selected channels within the same image.

8. Click **Options** to open the Save Image Options dialog and select text overlay color and telemetry information display options.

9. Click **Ok**.

10. In the Save window, click **Save**.
4.2. Viewing Telemetry Information

Telemetry information is data about vehicle location and performance captured from sensors in the DVR and the vehicle and includes the following:

- **GPS** — vehicle location and heading
- **Speed** — including current and excessive speed, in MPH or KPH
- **Signals** — up to 10 signals are available
- **Idle** — engine idle status (DX DVRs only)
- **G-Sensor**:
  - DVRs with internal G-Sensor units (including the HX, DX, and TX series), and TH series DVRs equipped with the external G-Sensor MDL, report motion from front to rear (X), left to right (Y), top and bottom (Z), and the force of motion (V).
  - MX and TL series DVRs equipped with the external XELR-8 G-Sensor report an alarm when acceleration thresholds are exceeded.

This section provides procedures for viewing telemetry information as data from the playback window viewing sections and in the Video Data tab.

**To view telemetry information in the Playback Window:**

1. In the Playback Window, right-click in an unused viewing section.
2. In the menu, select Display Telemetry, and choose a telemetry option. The telemetry data displays in the selected View Section.
4.2.1. GPS

GPS vehicle position tracking and data is collected using the GPS locator in the DVR. The vehicle’s position and route displays in map view when the HDD is connected to vMax View or a video clip is opened and one viewing channel is set to display GPS telemetry. The GPS data shows on the segment graph in magenta.

4.2.1.1. Archiving from GPS locations

For recorded data from DVRs with version 2.0 or newer firmware, the start and end times and locations of a vehicle route are displayed on the GPS telemetry view. The active selected route is highlighted. By clicking on any point of the active route, users can go to that point, start playing video from that point, or select an archive start and end time and place.

4.2.1.2. Archiving GPS Data

Once the archive end time is selected, users are prompted to save the archive. In the Save as type drop down list, users can choose to archive the GPS data (without video) as a file in .gpx, .kml, .xls, or .txt formats for viewing the GPS information in other applications.
4.2.2. Speed

Speed can be displayed as miles or kilometers per hour.
Recorded speed events are also displayed in the Video Data Telemetry tab.

4.2.3. Signals

Up to ten signals can be connected to the DVR. Signals are also displayed in the Video Data Telemetry tab. Double click a signal name to edit it.
To show and hide signals, click the plus/minus (±) symbol on the header or, on signal title rollover, click the red (-) button that appears.

4.2.4. Idle

When a vehicle with a DX series DVR is stationary with the motor running for a length of time, that interval can be detected and trigger event and alarm recordings. The Idle Limit Timer setting is selected on the Diagnostic Display menu in the DX series DVR. In vMax View, recorded idle events are also displayed in the Video Data Telemetry tab. See DVR Event Descriptions, on page A–2 for details on which DVRs support which events.
4.2.5. G-Sensor

The G-Sensor function detects forces on the DVR created by vehicle movement. Recorded G-Sensor events are also displayed in the Video Data Telemetry tab.

*Note: G-Sensor display is dependent on the DVR configuration used to capture the data. For details, see Viewing Telemetry Information, on page 4–4.*

To select the G-Sensor, click the single screen view option in the Video Display area to expand the window until the following view appears.

From the Front and Bottom drop down menus, select the preferred + or - axis.

G-Sensor defaults are:

- Front X+, Rear X-
- Left Y+, Right Y-
- Top Z+, Bottom Z-
4.3. Menu Item Descriptions

The File, Options, and Help menus provide further functionality and information.

4.3.1. File Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window</td>
<td>Click to open a new display window. In the new window, right click to access the display menu. Select a display option for the new window. <a href="#">See Using the Playback Window Menu, on page 3–14</a>.</td>
</tr>
<tr>
<td>Open</td>
<td>Click to open the Windows search dialog. Navigate to an archive file and click Open to play the archive in vMax View.</td>
</tr>
<tr>
<td>Archive</td>
<td>Click to archive the selected video segments.</td>
</tr>
<tr>
<td>Archive Wizard</td>
<td>Click to run the Archive Wizard. <a href="#">To use the Archive Wizard, see Using the Archive Wizard, on page 3–23</a>.</td>
</tr>
<tr>
<td>Validate Archive</td>
<td>Click to validate archives (.avr format) created in vMax View v4.2.0 and up, or vMax Commander v5.7 and up.</td>
</tr>
<tr>
<td>Print</td>
<td>Click to print an image of vMax View.</td>
</tr>
<tr>
<td>Exit</td>
<td>Click to close vMax View. Click OK in confirmation window.</td>
</tr>
</tbody>
</table>
### 4.3.2. Options Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Display Mode     | Click to select a camera view display option. Choose from:  
|                  | • Single Channel                                                                                                                           |
|                  | • 4-Channels                                                                   |
|                  | • 6-Channels                                                                   |
|                  | • 9-Channels                                                                   |
|                  | • 13-Channels                                                                  |
|                  | • 16-Channels                                                                  |
|                  | • Default (channel count of the DVR type used for recording)                                                                            |
| Audio            | Click to select an audio channel playback option.  
|                  | Choose from Audio Channel 1 up to 16, depending on the DVR.  
|                  | The selected audio channel will play while the video displays.                                                                           |
| Resolution*      | Click to choose a display resolution for all cameras; select **All High** or **All Low**.  
| * Available only when viewing video from an HX16 DVR | Defaults: HX analog - all low, HD - all high.  
|                  | DX TX MX TL TH: analog & HD (if available) -all high.  
|                  | SD card: - all low.                                                            |
| Configuration    | Click to save your vMax View display and archiving settings.  
|                  | • In the Display tab, select Save, Load, or Reset Configurations.  
|                  | • In the Archiving tab, view the settings and launch the Archive Wizard to edit settings if required.                                |
| Segmented Archive| Click to enable or disable segment stitching. When Stitch is selected, selecting any archive segment will load the entire group of segmented archives to play. When not selected, only the selected archive segment will play. |
| Users            | If login is enabled, click to create and edit vMax View user login settings.                                                             |
| Language         | Select the language to display in vMax View. Choose from:  
|                  | • English                                                                      |
|                  | • Español                                                                      |
|                  | • Français                                                                     |
4.3.2.1. vMax View Configuration Options

You can save your vMax View settings so that whenever you open vMax View, it displays your preferred video, audio, and telemetry display options.

The images below show the default configuration and a custom configuration,

Default Configuration:
- The number of camera views displayed is based on the channel count of the DVR type used to create the recording - 4 in this example
- Audio channel 1 selected

Custom Configuration:
- 9 camera views, including two telemetry views
- Audio channel 3 selected
1. In the Options menu, click Configuration.
2. In the Configuration dialog select the Display tab.

![Configuration Window]

3. See the following configuration menu options and when complete click Apply to save the settings or click OK to close the Configuration window.

4.3.2.2. Save a Configuration

4. Click Save Configuration.

![Save Configuration Window]

5. Enter the configuration name and a description and click Save.
6. In the Confirmation dialog, click OK.
4.3.2.3. Load or Delete a Configuration

7. In the Configuration window, click Load Configuration.

8. Select the configuration and click Load.
9. In the Confirmation dialog, click OK.
10. To delete a Configuration, select and click Delete.
11. In the Confirmation dialog, click Yes.

4.3.2.4. Reset Default Configuration

12. In the Configuration window, click Reset Configuration.
13. In the Confirmation dialog, click OK.

The default configuration displays the number of channels supported by the DVR type used to create the recording. For example, the HX16 DVR supports 16 channels; therefore, the default configuration opens an HX16 recording in 16-channel view.
4.3.2.5. Users

If enabled during installation, vMax View has 2 levels of users; Administrator and User.

On the PC, the Administrator must ensure that anyone who is going to be logging into vMax View needs to have full read/write access to the folder where vMax View is installed. See Installing or Upgrading vMax View, on page 2–2.

The Administrator can create and edit other user settings.

Security Tip: Update Password

The default user name and password is “admin”. For security purposes, Seon recommends that the user default login and system settings passwords should be changed. Seon is not responsible if the changed password is lost or forgotten.

Administrator — To set up user permissions:
1. From the vMax View Options menu, select Users.
2. In the Users and Passwords window, click New User to create a new user profile.

   ![Users and Passwords window]

3. Enter a user name and password.
4. Confirm the password.
5. Select the language that vMax View will display in all menus and dialogs.
6. Select the user privilege
   - **Administrator** — creates and edits users and has full access to all vMax View functionality.
   - **User** — has full access to all vMax View functionality except creating and editing users.
7. To deny access to the selected user, select the Disable User check box.
8. Click Save Changes.
9. Click Close when all user permissions have been edited and saved.
4.3.3. Help Menu

![vMax View Help Menu](image)

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Start Guide</td>
<td>Click to open the vMax View Quick Start Guide. Adobe PDF Reader required.</td>
</tr>
<tr>
<td>User Guide</td>
<td>Click to open this vMax View User Guide. Adobe PDF Reader required.</td>
</tr>
<tr>
<td>About vMax View</td>
<td>Click to view the About vMax View window and view the software version number.</td>
</tr>
</tbody>
</table>

10. Navigate the help for information on vMax View.

4.3.3.1. vMax View Software Version

The vMax View software version is available from the Help menu. When contacting Customer Service, please have the software version available.

**To display the software version:**

1. In vMax View, click **Help > About vMax View**.
The About vMax View window appears with the software version displayed.

![Software Version](image)

2. If necessary, copy down the version number.
3. Click OK to close About vMax View.
GPS Tracking, Telemetry, and Other Features
# Troubleshooting

## 5.1. Troubleshooting Table

This chapter provides information and procedures for troubleshooting the DVR drive interface and the vMax View software.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| vMax View takes a long time to open an archive. | The selected archive file is very large (several hours of video from multiple cameras), and/or the archive is being opened over a network. An external USB drive may be causing problems. | Do one of the following:  
• Download a smaller archive file from the DVR hard drive.  
• Move the archive video from a network location to your local computer to open it in vMax View.  
• View the video directly from the DVR hard drive.  
• Disconnect any other external drives from the computer when using vMax View. |
| The vMax View software program will not start. | The vMax View software may not be installed.  
Sound and video drivers are not compatible. | If the problem continues, install the latest vMax View software program. See Installing or Upgrading vMax View on page 2–2.  
Check that you also have up-to-date sound and video drivers installed.  
See System Requirements on page 2–1 for PC specifications. |
| vMax View detects only one of the dual hard drives of a DX-HD, DX12, or TX8 HDD cartridge. | This message can be generated because either the DVR drive interface failed or one of the dual hard drives failed. | Close vMax View. Turn off the DVR drive interface, wait 5 seconds. Remove the dual DVR drive from the DVR drive interface. Reinstall the dual DVR drive to the DVR drive interface, confirming it is properly seated. Turn on the DVR drive interface. Open vMax View and confirm whether or not the dual drive is detected.  
• If vMax View detects the dual HDD drive, the issue was likely because the dual HDD drive was not properly seated in the DVR drive interface.  
• If vMax View again reports only one drive seen, repeat the steps above with a different dual HDD drive of the same type.  
• If vMax View reports an issue with the second dual HDD drive, contact Seon.  
• If both drives in the second dual HDD drive are read by vMax View, one of the drives in the original dual HDD drive has failed. The dual HDD drive should be replaced. |
<p>| .avr files fail to play in vMax View on Windows Server2012. | Windows User Interfaces and Infrastructure options are not enabled in Windows Server2012. | In Windows Server2012 &gt; Server Manager &gt; Add Roles and Features Wizard, scroll the Features List and select the User Interfaces and Infrastructure check box and it’s Graphical, Desktop, and Server sub option check boxes. |</p>
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No vMax View audio output on Windows 8 PC.</td>
<td>Windows 8 audio output has been configured for digital sound.</td>
<td>Set Windows 8 audio to analog sound output.</td>
</tr>
<tr>
<td>Channel 1 does not print from vMax View File &gt; Print or Windows Print Screen button.</td>
<td>Windows Direct Show does not support channel 1 output conversion to jpeg.</td>
<td>Move channel 1 camera output to another unused camera channel.</td>
</tr>
<tr>
<td>In Windows 8, vMax View archive download completes but won’t play.</td>
<td>Region format settings are not English (US).</td>
<td>Set Windows 8 region settings to English(US).</td>
</tr>
<tr>
<td>DVR drive interface indicators are not illuminated.</td>
<td>The DVR drive may not be properly inserted or connected to the DVR drive interface.</td>
<td>Check that the DVR drive is properly seated, or firmly mounted in the DVR drive interface. Check that the power adapter cable and the USB cable are securely connected to the DVR drive interface and the computer. Close and reopen the vMax View software program on your computer. Turn off power to the DVR drive interface and insert the drive. See Connecting the DVR HDD DOCK on page 2–8.</td>
</tr>
<tr>
<td>Archives or images can’t be located once created.</td>
<td>By default, vMax View saves all files at C:\Program files\Seon\vMax3\vMax3</td>
<td>When saving files, in the Save in menu, choose another location to confirm you know where the file will be found.</td>
</tr>
<tr>
<td>Error message is displayed “Invalid EDSR media”.</td>
<td>The hard drive may not contain Seon media, or may have been damaged.</td>
<td>Check that the DVR drive has been recording. Take the DVR drive interface to the vehicle, and use an LCD monitor to see if there are any segments listed when you search by segment. See Searching for Video by Time or Events on page 3–16, or call Seon Support for assistance. If there are no images recorded on the DVR drive, make sure the drive is locked into the DVR. Otherwise, the unit will turn ON but will not record.</td>
</tr>
<tr>
<td>GPS mapping doesn’t work.</td>
<td>No Internet access.</td>
<td>Ensure that your computer has access to the Internet and Google maps. Your IT department may need to adjust computer settings (port blocking) to enable access.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The video clips are too large.</td>
<td>Depending on the DVR settings, the video clips can get very big; for example, if there are a lot of alarms, or very high resolution settings.</td>
<td>Seon recommends a maximum file size of 15 minutes for archive video clips. For video clips longer than 15 minutes, consider archiving as separate clips. Refer to your DVR User Guide for the approximate sizes of the images at the different rates of recording. If you are running a previous version, contact Seon for the newest version of the vMax View software to reduce the size of the archived clips.</td>
</tr>
<tr>
<td>Video playback is choppy or inconsistent.</td>
<td>The computer is low on the resources needed to playback video.</td>
<td>Check if other programs are running in the background, for example, Microsoft Outlook. If you have other programs running, close these programs and playback the clips. Check that the PC specifications meet the vMax View operating requirements or PC specifications. See System Requirements on page 2–1. When viewing video from an HX16 DVR, only use high resolution display for channels of interest, and select low resolution for all other channels. For more information, see Selecting HX16 Video Display Resolution on page 3–10. Run the Disk Defragmenter application on your computer to free up extra hard drive space to play back clips. Click on Start, click on All Programs, click on Accessories, click on System Tools, and then click on Disk Defragmenter.</td>
</tr>
<tr>
<td>Some of the cameras are not being displayed.</td>
<td>The incorrect DVR type is selected in the Video Display selection area, or single channel is selected.</td>
<td>Check if the other cameras display when you press the PLAY button on the DVR front panel. Right-click on the Video Display area and select Display Mode. Click on the correct option (1, 4, 6, 9, 13, or 16) for your DVR model. See Using the Playback Window Menu on page 3–14.</td>
</tr>
<tr>
<td>Cannot set archive times.</td>
<td></td>
<td>See Archive File Types on page 3–18 to set the archive start and stop times.</td>
</tr>
<tr>
<td>Unable to detect the drive and contents.</td>
<td>Other types of external hard drives may be plugged in to the computer.</td>
<td>Disconnect any other external drives from the computer when using vMax View.</td>
</tr>
<tr>
<td>Unable to detect the drive and contents.</td>
<td>Drive adapter and cable connections may not be connected.</td>
<td>Check that the DVR drive interface is on and connected. The DVR drive interface should be turned off when changing the drives.</td>
</tr>
<tr>
<td>“No Media Available” message is displayed.</td>
<td>There is a point in the media where some/all channels have stopped recording.</td>
<td>Ensure DVR settings are allowing the equipment to record during the times desired. Im proper DVR operation/shutdown may have occurred within archiving times; this message announces that time has jumped within an archive.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program stops responding when new drives are added.</td>
<td>Computer operating system may not be informing the application of additional drives.</td>
<td>Ensure USB devices are properly removed, and the DVR drive interface is turned off when switching drives.</td>
</tr>
<tr>
<td>Program installation generates errors.</td>
<td>Program may already be running.</td>
<td>Ensure all instances of Seon software programs are closed before attempting installation or updates.</td>
</tr>
</tbody>
</table>
Appendix A

Specifications

This appendix provides the product specifications for the vMax View Video Management Software.

**Note:** Specifications are subject to change without notice.

### A.1. vMax View Software

#### Playback Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels</td>
<td>View 1, 4, 6, 9, 13, or 16 video channels simultaneously.</td>
</tr>
<tr>
<td>Playback speed</td>
<td>Change the playback speed from 1/8× to 32× normal speed.</td>
</tr>
<tr>
<td>Forward or backward</td>
<td>• Play video segments forward or backward.</td>
</tr>
<tr>
<td></td>
<td>• Slow forward or reverse.</td>
</tr>
<tr>
<td></td>
<td>• Use a slider control to quickly move forward or backward.</td>
</tr>
<tr>
<td>Zoom</td>
<td>User adjustable zoom level in each video display area.</td>
</tr>
<tr>
<td>Display text</td>
<td>Show/hide video text displaying signal/speed/GPS data.</td>
</tr>
<tr>
<td>Search options</td>
<td>• From a Segment list</td>
</tr>
<tr>
<td></td>
<td>• From an Events list</td>
</tr>
<tr>
<td></td>
<td>• By date and time</td>
</tr>
</tbody>
</table>

#### Archiving Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Format</td>
<td>Individual audio/ 1 or more video channels to .avi or .wmv files</td>
</tr>
<tr>
<td>Text Format in Video Files</td>
<td>Signal/speed/GPS data as text overlays</td>
</tr>
<tr>
<td>Proprietary Formats</td>
<td>All audio/video channels and signal/speed/GPS data. .avr or .avs files (Seon proprietary formats)</td>
</tr>
<tr>
<td>Images</td>
<td>Individual video images to .bmp or .jpg files or to printer</td>
</tr>
</tbody>
</table>

#### Mapping Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping software</td>
<td>Google Maps</td>
</tr>
<tr>
<td>Vehicle position</td>
<td>Displays position of vehicle on street map.</td>
</tr>
<tr>
<td>Synchronicity</td>
<td>Vehicle position displayed in a separate Map Viewer window, synchronized with the video playback</td>
</tr>
<tr>
<td>Maps</td>
<td>Complete maps of the US and Canada are provided.</td>
</tr>
<tr>
<td>Zoom</td>
<td>User adjustable zoom level</td>
</tr>
<tr>
<td>Auto Center/Scroll</td>
<td>Configurable auto center/scroll (white arrow)</td>
</tr>
<tr>
<td>Views</td>
<td>Configurable to show only the vehicle’s current position or path.</td>
</tr>
<tr>
<td>Transferability</td>
<td>Copy and paste the map display to Microsoft Office applications such as Word and Power Point, for example.</td>
</tr>
</tbody>
</table>
A.2. DVR Event Descriptions

The following table provides definitions for DVR event types that may display in the Events and Alarms tabs of the Video Data area in vMax View.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>HX16</th>
<th>DX-HD</th>
<th>DX12</th>
<th>TX8</th>
<th>MX-HD</th>
<th>MX4</th>
<th>TH6</th>
<th>TL-HD</th>
<th>TL4/2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alm\n Off</td>
<td>Alarm Off</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Alm\n On</td>
<td>Alarm On</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>EXSpeed</td>
<td>Excessive speed occurred</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>FAN</td>
<td>Fan fault</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GPS</td>
<td>Crossed GPS Fence</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GSN</td>
<td>Gsensor exceeded limit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GSN X-</td>
<td>Limit exceeded in X-</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GSN X+</td>
<td>Limit exceeded in X+</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GSN Y-</td>
<td>Limit exceeded in Y-</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GSN Y+</td>
<td>Limit exceeded in Y+</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GSN Z-</td>
<td>Limit exceeded in Z-</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GSN Z+</td>
<td>Limit exceeded in Z+</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Idle0</td>
<td>Idle limit not exceeded/ stopped</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Idle1</td>
<td>Idle limit exceeded/ stopped</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IG0</td>
<td>Ignition off</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>IG1</td>
<td>Ignition on</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>LIVE</td>
<td>DVR changes to live mode</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PLoss</td>
<td>Power Loss</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rec On</td>
<td>Normal Recording event</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Run</td>
<td>Remote User Login n</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Signal</td>
<td>Signal Event n</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Vlossn</td>
<td>Video loss on channel n</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Legal Notice

Seon Design® Inc.

Seon Design Inc. is a specialist in the design and manufacture of video surveillance systems for mobile applications. Seon has been the preferred solutions provider for the pupil transportation industry since 1999. Today, we are proud that our success in this area has made us the leading manufacturer of mobile video surveillance systems in North America.

Contact Information

Seon Design Inc., Unit 111, 3B Burbidge Street, Coquitlam, BC Canada V3K 7B2

<table>
<thead>
<tr>
<th>Telephone</th>
<th>604.941.0880</th>
<th>Toll Free Telephone</th>
<th>1.877.630.7366</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax</td>
<td>604.941.0870</td>
<td>Toll Free Fax</td>
<td>1.866.664.3677</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:sales@seon.com">sales@seon.com</a></td>
<td>Web site</td>
<td><a href="http://www.seon.com">www.seon.com</a></td>
</tr>
</tbody>
</table>

Seon Design Inc. Trademarks

Seon Design Inc. holds the following trademarks:
- vMax View™ are registered trademarks of Seon Design Inc.
- Rogue™, Rogue™ Plus, Explorer™, and Trooper® are registered trademarks of Seon Design Inc.
- “Seon Design” is a registered trademark of Seon Design Inc. The Seon logo (seon) is a registered trademark of Seon Design Inc.

In this User Manual there are references to trademarks, registered trademarks, and product names not owned by Seon Design Inc. that are the property of their respective owners. They are used in this User Manual for identification purposes only.

User Manual Revision

This is the R15 revision for this User Manual and is copyright, March 2017 by Seon Design Inc. All rights reserved.

Exclusion of Liability

SEON DESIGN INC.:

(a) MAKES NO REPRESENTATION, WARRANTY, GUARANTEE OR COVENANT, EXPRESS OR IMPLIED, AS TO THE ACCURACY, SUFFICIENCY OR SUITABILITY OF ANY TECHNICAL OR OTHER INFORMATION PROVIDED IN THIS USER MANUAL OR ANY OTHER USER OR OTHER MANUAL OR OTHER DOCUMENTATION PROVIDED BY SEON DESIGN INC. WITH RESPECT TO THE PRODUCT(S) DESCRIBED HEREIN, INCLUDING WITHOUT LIMITATION ANY DESCRIPTION OF GOODS OR SERVICES, SPECIFICATIONS, MODELS, DRAWINGS, OR DIAGRAMS.

(b) DOES NOT ASSUME AND SHALL NOT BE SUBJECT TO AND DISCLAIMS ANY AND ALL RESPONSIBILITY AND/OR LIABILITY FOR LOSSES, DAMAGES, COSTS OR EXPENSES ARISING OUT OF BREACH OF CONTRACT OR OF WARRANTY, TORT (INCLUDING NEGLIGENCE AND STRICT LIABILITY) OR OTHERWISE, WHETHER SPECIAL, DIRECT, INDIRECT, CONSEQUENTIAL, INCIDENTAL, SPECIAL OR CONTINGENT, WHICH MIGHT ARISE OUT OF THE USE OF SUCH INFORMATION. THE USE OF ANY SUCH INFORMATION WILL BE ENTIRELY AT THE USER’S RISK; AND

(c) EXPRESSLY DISCLOSES THAT IF THIS MANUAL IS WRITTEN IN ANY LANGUAGE OTHER THAN ENGLISH, THAT ALTHOUGH SEON DESIGN INC. HAS USED REASONABLE CARE TO MAINTAIN THE ACCURACY OF THE TRANSLATION FROM THE ENGLISH LANGUAGE, THE ACCURACY OF SUCH TRANSLATION IS NOT GUARANTEED OR WARRANTED BY SEON DESIGN INC. PLEASE REFER TO THE ENGLISH LANGUAGE VERSION OF THIS USER MANUAL FOR APPROVED SEON CONTENT. THE ENGLISH LANGUAGE VERSION IS AVAILABLE UPON REQUEST FROM THE SEON CUSTOMER SERVICE DEPARTMENT.

Please refer to the Seon Design Inc. Product Warranty applicable to the Product(s) described in this User Manual which exclusively sets forth Seon Design Inc.’s entire liability arising from or in connection with such product(s) and their use and the exclusive remedies available for purchasers and users thereof.

Document Part Number

This User Manual is valid for Seon Design Inc. Document Part Number 700-0137.

Printed in Canada
End-User License Agreement
For Seon Design Inc. Software

End-User License Agreement

This End-User License Agreement (the "Agreement") is a legal agreement between you (either an individual or a single entity) and SEON DESIGN INC. ("SEON"), for the use of one or more elements of the SEON proprietary software, that accompanies this Agreement (individually or collectively referred to as the "SOFTWARE"). The SOFTWARE may also include any updates and supplements to the original SOFTWARE provided to you by SEON.

BY INSTALLING, COPYING, OR USING THE SOFTWARE YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT IF YOU DO NOT AGREE, DO NOT INSTALL, COPY, OR USE THE SOFTWARE; YOU MAY RETURN IT TO YOUR PLACE OF PURCHASE FOR A FULL REFUND, IF APPLICABLE.

This Agreement is made by and between you (the "LICENSEE") and SEON.

WHEREAS:
A. SEON has developed the SOFTWARE;
B. The LICENSEE wishes to use the SOFTWARE in accordance with the terms set forth herein;
NOW THEREFORE, in consideration of the forgoing and in consideration of the mutual promises, warranties, and covenants contained herein, the sufficiency of which is hereby acknowledged, the undersigned parties agree as follows:

1. SOFTWARE License
1.1 SOFTWARE License. SEON grants to the LICENSEE a non-transferable, non-exclusive, limited license to:
(a) install and use a copy of the SOFTWARE on one personal computer or other device; and
(b) install an additional copy of the SOFTWARE on a second, portable device for the exclusive use of the primary user of the first copy of the SOFTWARE.

1.2 License Grant for Remote Assistance. The LICENSEE may permit any device to access and use its licensed copy of the SOFTWARE for the sole purpose of providing the LICENSEE with technical support and maintenance services.

1.3 Third Party Software. Any other software or materials accompanying this Agreement that is not owned by SEON and that is associated with a separate end-user license agreement is licensed to the LICENSEE under the terms of that license agreement.

1.4 License Grant for Documentation. The documentation the ("Documentation") that accompanies the SOFTWARE is licensed for internal, non-commercial reference purposes only.

1.5 Reservation of Rights. SEON reserves all rights not explicitly granted herein. All licenses granted to the LICENSEE in this Agreement herein are non-exclusive. Nothing in this Agreement shall be construed as limiting in any manner SEON’s marketing or distribution activities or the licensing of the SOFTWARE by the SEON to any third party. The SOFTWARE is licensed, not sold.

1.6 Restrictions. The License granted hereby is for the SOFTWARE in object code form only and, subject to Section 2.4, the LICENSEE shall not:
(a) use, copy, republish or distribute the SOFTWARE, or cause or permit any person to use, copy, republish or distribute the SOFTWARE, except as expressly permitted under this Agreement;
(b) loan, sell, rent, lease, sublicense, grant a security interest in, republish, distribute, loan or otherwise transfer rights to the SOFTWARE, in whole or in part;
(c) directly or indirectly attempt in any way to derive the source code, content, structure, sequence or organization of all or any portion of the SOFTWARE, nor will attempt to modify, port, reverse engineer, de-compile, or translate the SOFTWARE, or to create derivative works thereof;
(d) remove any proprietary notices or labels from the SOFTWARE.

1.7 Back Up Copy. The LICENSEE is authorized to make one copy for archive purpose of the SOFTWARE, in non-printed machine language object code form only.

1.8 LICENSEE Indemnification. The LICENSEE shall indemnify, defend and hold SEON and its affiliates, officers, directors, agents and employees harmless from any losses, liabilities, damages, costs or expenses, including reasonable attorney’s fees, arising out of any breach by the LICENSEE of its obligations under this Agreement or any unauthorized alteration, modification, adjustment or enhancement made by the LICENSEE to the SOFTWARE or the Documentation.

1.9 Trademarks. The LICENSEE acknowledges and agrees that this Agreement does not grant the LICENSEE any rights to use any trademarks or trade names of SEON or their licensors. All such marks shall remain the property of the respective owner.
2. **SEON Warranty**

2.1 **Warranty.** SEON represents and warrants to the LICENSEE that for a period of ninety (90) days from the receipt of the SOFTWARE by the LICENSEE the tangible media on which the SOFTWARE is recorded will be free from defects in materials and workmanship under normal use.

2.2 **Remedies.** SEON’s entire liability and the exclusive remedy of the LICENSEE for any breach of the limited warranty set out in Section 2.1 shall be replacement upon receipt by SEON of the defective media not meeting SEON’s limited warranty. SEON will have no responsibility to replace media damaged by accident, abuse or misapplication.

3. **Disclaimers, Warranties and Limitation of Liability**

3.1 **NO WARRANTIES.** SEON DISCLAIMS ANY AND ALL WARRANTIES WITH RESPECT TO THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND ANY OTHER EXPRESS WARRANTIES OR SIMILAR OBLIGATIONS (IF ANY) CREATED BY ANY ADVERTISING, DOCUMENTATION, PACKAGING OR OTHER COMMUNICATIONS. THE LICENSEE ACKNOWLEDGES THAT IT HAS NOT RELIED ON ANY WARRANTY MADE BY SEON. THE SOFTWARE IS PROVIDED ON AN “AS IS WITH ALL FAULTS” BASIS WITH NO WARRANTY, EXPRESS OR IMPLIED AND SEON HAS NO OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS OR MODIFICATIONS WITH RESPECT TO THE SOFTWARE TO THE LICENSEE. THERE IS NO WARRANTY OR CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION, CORRESPONDENCE TO DESCRIPTION OR NON-INFRINGEMENT WITH REGARD TO THE SOFTWARE.

3.2 **EXCLUSION OF OTHER WARRANTIES.** THE LICENSEE ACKNOWLEDGES THAT THE SOFTWARE MAY CONTAIN ERRORS AND MAY BE INCOMPLETE OR CONTAIN INACCURACIES AND THAT EXCEPT AS EXPRESSLY SET OUT IN SECTION 2.1 SEON DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF THE LICENSEE, THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHER, SEON DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY OR OTHERWISE.

3.3 **LIMITATION OF LIABILITY.** IN NO EVENT SHALL SEON BE LIABLE FOR ANY DAMAGES SUFFERED OR INCURRED BY THE LICENSEE OR ANY OTHER PERSON OR ENTITY INCLUDING, WITHOUT LIMITATION, ANY SPECIAL, PUNITIVE, INCIDENTAL, INDIRECT, DIRECT, PUNITIVE OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, LOSS OF REVENUE, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, FOR PERSONAL INJURY, FOR LOSS OF PRIVACY, FOR FAILURE TO MEET ANY DUTY INCLUDING OF GOOD FAITH OR OF REASONABLE CARE, FOR NEGLIGENCE, OR ANY OTHER PECUNIARY LOSS WHATSOEVER) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF SEON HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

4. **No Exclusivity**

4.1 **No Exclusivity.** Nothing in this Agreement nor the license of the SOFTWARE shall constitute or imply any promise to or intention to make any purchase of products or services by either party or its affiliates or any commitment by either party or its affiliates with respect to the present or future marketing of any product or service or any commitment to enter into any other business relationship.

5. **Termination.**

5.1 **Termination.** Without prejudice to any other rights, SEON may terminate this Agreement if the LICENSEE fails to comply with the terms and conditions of this Agreement. In such event, The LICENSEE shall destroy all copies of the SOFTWARE and all of its component parts.

6. **Restricted Rights.**

6.1 **Restricted Rights.** The SOFTWARE was developed at private expense, is commercial, and is published and copyrighted. The SOFTWARE may be transferred to the U.S. government only with the prior written consent of an officer of Licensor and solely with “Restricted Rights” as that term is defined in FAR 52.227-19(c)(2) (or DFAR 252.227-202.32 (c)(1) if the transfer is to a defence-related agency) or subsequent citation. If LICENSEE is an agency of the United States government or licensing the SOFTWARE for operation on behalf of the United States government, the SOFTWARE is licensed to LICENSEE with rights no greater than those set forth in Federal Acquisition Regulation 52.227-19(c)(2) [or DFAR 252.227-702.32 (c)(1) if the LICENSEE is a defence-related agency] or subsequent citation.

7. **LICENSEE Representations**

7.1 **Binding Effect.** By accepting delivery of the SOFTWARE, copying, accessing or otherwise using the SOFTWARE, the LICENSEE represents and warrants to SEON that the LICENSEE has all requisite power and authority to enter into this Agreement and has all necessary power and authority to perform the obligations of the LICENSEE as set out herein.

8. **General**

8.1 **Assignment.** The LICENSEE may not assign, sublicense, transfer or encumber this Agreement without the prior written consent of SEON. Subject to the limitations set forth in this Agreement, this Agreement will inure to the benefit of and be binding upon the parties, their successors and permitted assigns.

8.2 **Separation of Components.** The SOFTWARE is licensed as a single product. Its component parts may not be separated for use license, distribution or replacement by the LICENSEE.

9. **Governing Law, Jurisdiction and Venue**
9.1 **Provisions Applicable to American LICENSEES.** SEON is physically located within the Province of British Columbia, Canada. For those LICENSEES whose mailing address is in the United States, this agreement shall be governed by and construed in accordance with the internal and domestic laws of the State of WASHINGTON without giving effect to the conflict of laws rules thereof. The Superior Court of Washington for Whatcom County and U.S. District Court for the Western District of Washington (“the U.S. Closed Courts”) shall have exclusive jurisdiction to hear and make any judicial determination on any issue arising with respect to this Agreement. We expressly exclude the UN Convention on Contracts for the International Sale of Goods as amended, replaced or re-enacted from time to time.

9.2 **Provisions Applicable to Other LICENSEES.** SEON is physically located within the Province of British Columbia, Canada. For those LICENSEES whose mailing address is NOT in the United States, this Agreement will be governed by and construed in accordance with the laws of the Province of British Columbia and the laws of Canada applicable therein. The parties agree that the Courts of the Province of British Columbia shall have exclusive jurisdiction to hear and make any judicial determination on any issue arising with respect to this Agreement. We expressly exclude the UN Convention on Contracts for the International Sale of Goods as amended, replaced or re-enacted from time to time. We have required that this Agreement and all documents relating thereto be drawn-up in English. NOUS avons demande que cette convention ainsi que tous les documents qui s'y rattachent soient reёges en anglais.

10. **Entire Agreement**

10.1 **Entire Agreement.** This Agreement constitutes the entire understanding between the parties hereto and supersedes all previous communications, representations and understandings, oral or written, between the parties, with respect to the subject matter of this Agreement.
Seon Design Inc.
Unit 111, 3B Burbidge Street
Coquitlam, BC
Canada V3K 7B2

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Telephone</td>
<td>604.941.0880</td>
</tr>
<tr>
<td>Toll Free</td>
<td>1.877.630.7366</td>
</tr>
<tr>
<td>Fax</td>
<td>604.941.0870</td>
</tr>
<tr>
<td>Toll Free</td>
<td>1.866.664.3677</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:sales@seon.com">sales@seon.com</a></td>
</tr>
<tr>
<td>Web site</td>
<td><a href="http://www.seon.com">www.seon.com</a></td>
</tr>
</tbody>
</table>